RL78 Family

Reality AI Data Acquisition Module (Data Collector / Data Shipper) – Sample Code

Introduction

This application note describes sample software for data acquisition for Reality AI. Acquired data is converted into any files using Reality AI Data Storage Tool on PC.

Target Device

RL78 Family MCUs: G23, G24, G13, G13A, G1D, G1H, G14 (ROM size more than 128KB)

- Operation confirmed MCU: RL78G23

When using this application note with other Renesas MCUs, careful evaluation is recommended after making modifications to comply with the alternate MCU.

Contents

1. Data acquisition for Reality AI ................................................................. 2
   1.1 Overview of Data Collector ................................................................. 2
   1.2 Overview of Data Shipper ................................................................. 2
   1.3 Overview of Data Storage Tool ......................................................... 2

2. How to implement data acquisition .......................................................... 3
   2.1 Create New project ............................................................................. 3
   2.2 Import and setup for SIS Modules for Reality AI .................................... 7
   2.3 Import sample project for Data Collector and Data Shipper .................. 20
   2.4 Setup Data Collector ........................................................................ 21
   2.5 Setup Data Shipper .......................................................................... 23
   2.5.1 Setup UART for Data Shipper .......................................................... 24
   2.6 Generate source code by smart configurator ....................................... 25
   2.7 Modify source code ......................................................................... 25
   2.8 Build project .................................................................................... 26

3. How to get sensor data from evaluation board ......................................... 26
   3.1 Setup Reality AI Data Storage Tool ..................................................... 26
   3.2 Connect Evaluation Board and PC ....................................................... 30
   3.3 Modify debugger settings ................................................................ 30
   3.4 Execute program ............................................................................. 33
   3.5 Get sensor data ................................................................................ 34

Revision History ......................................................................................... 36
1. Data acquisition for Reality AI

Follow the steps below to collect data for Reality AI.

- Signal data such as sensors are stored in memory by Data Collector.
- The stored data is sent to the PC Data Shipper.
- Data Storage Tool running on a PC converts it into a file and uploads it to Reality AI.

Reality AI analyzes uploaded data and generates source code. Please see the e2 studio documentation for information on how Reality AI and e2 studio work together.

The following diagram is the system structure.

1.1 Overview of Data Collector

Data Collector collects data such as sensors in memory. There are two ways to collect it.

- **Snapshot**
  
  Data is collected using a timer provided by the Data Collector.

- **Data Feed**
  
  Data is collected using a timer provided by the user.

After collecting a specified number of data, it calls the Data Shipper’s API.

1.2 Overview of Data Shipper

Data Shipper sends data stored in memory by Data Collector to the PC via UART.

UART settings are set in “UART Communication Driver Interface Middleware”.

1.3 Overview of Data Storage Tool

Data Storage Tool convert file from sent data by Data Shipper.
2. How to implement data acquisition

Describes how to implement a data acquisition module using Data Collector and Data Shipper into a program.

2.1 Create New project.

1. Select [File] > [New] > [Renesas C/C++ Project] > [Renesas RL78] menu.
3. Specify Project Name.

Push [Next] button.

Push [Next] and [Finish] button to create a new project.
2.2 Import and setup for SIS Modules for Reality AI

1. Open Smart Configurator.

   Double Click ["projectname".scfg] in Project Explorer.
2. Add Components.

Select [Components] tab and Click [Add component] icon.
3. Download FIT modules.
   - Select [Download RL78 Software Integration System modules] link.
Select Region on dialog.

- Check the following SIS modules in list.
  - RAI Data Collector Middleware
  - RAI Data Shipper Middleware
  - UART Communication Driver Interface Middleware

Push [Download] button

Confirm “End User License Agreement (Sample Code)”. If you can agree this license, push [Accept] button.

When select [RAI Data Shipper Middleware], Smart Configurator will automatically import the required components.

4. Import Data Transfer Controller (DTC) and setup.

Data Collector use DTC feature. So, import Code Generator module.

– Select [Components] tab and Click [Add component] icon in Smart Configurator.
– Select [Data Transfer Controller] item and push [Finish] button.
– Change the settings of [Config_DTC] as follows:

<table>
<thead>
<tr>
<th>Items</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chain transfer (DTCD0)</td>
<td>Check</td>
</tr>
<tr>
<td>Activation source (DTCD0)</td>
<td>End of channel 1 of timer array unit 0 count or capture</td>
</tr>
</tbody>
</table>
5. Import Interval Timer and setup.

Data Collector use timer. So, import SIS module and change the settings.

- Select [Components] tab and Click [Add component] icon in Smart Configurator.
- Select [Interval Timer] item and push [Next] button.
Change [16bit count mode] of “Operation” and push [Finish] button.
– Change the settings of [Config_TAU0_1] as follows:

<table>
<thead>
<tr>
<th>Items</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval value (16 bits)</td>
<td>1 ms</td>
</tr>
<tr>
<td>Priority</td>
<td>Level 0 (high)</td>
</tr>
</tbody>
</table>

6. Import UART communication and setup.

Data Shipper use UART communication. So, import code generator module and change the settings.

– Select [Components] tab and Click [Add component] icon in Smart Configurator.
- Select [UART communication] item and push [Next] button.

– Change the settings of [Config_UART3] and [Transmission] tab as follows:

<table>
<thead>
<tr>
<th>Items</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock source</td>
<td>fCLK/2</td>
</tr>
<tr>
<td>Transfer rate setting</td>
<td>115200 (bps)</td>
</tr>
</tbody>
</table>
Change the settings of [Config_UART3] and [Reception] tab as follows:

<table>
<thead>
<tr>
<th>Items</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock source</td>
<td>fCLK/2</td>
</tr>
<tr>
<td>Transfer rate setting</td>
<td>115200 (bps)</td>
</tr>
</tbody>
</table>
2.3 Import sample project for Data Collector and Data Shipper

A sample project created using the steps described in this application note is attached with this application note. Please import by the following steps. Please refer to the imported project as necessary.

- Right-button click [rm_rai_data_shipper_rl] in tree of Smart Configurator and select [Download and import sample projects] menu.

- Launch [Smart Browser] view and right button click [RL78 Family Reality AI Data Acquisition Module (Data Collector / Data Shipper) - Sample Code] list and select [Sample Code(import projects)] menu.

- Select [RealityAI_DataAcquisition_RL78G23_NonOS] item
2.4 Setup Data Collector

- Change the settings of `[rm_rai_data_collector_rl]` as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot Mode Channel 0 Name</td>
<td>Data1</td>
</tr>
<tr>
<td>Snapshot Mode Channel 0 Data</td>
<td>8-bit Signed</td>
</tr>
<tr>
<td>Snapshot Mode Channel 1 Name</td>
<td>Data2</td>
</tr>
<tr>
<td>Snapshot Mode Channel 1 Data</td>
<td>8-bit Unsigned</td>
</tr>
<tr>
<td>Snapshot Mode Channels</td>
<td>2</td>
</tr>
<tr>
<td>Timer Driver Type</td>
<td>16-bits counter</td>
</tr>
<tr>
<td>Timer Component name</td>
<td>Config_TAU0_1</td>
</tr>
<tr>
<td>DTC Component name</td>
<td>Config_DTC</td>
</tr>
</tbody>
</table>
2.5 Setup Data Shipper

- Change the property of \[\text{rm\_rai\_data\_shipper\_rl}\] as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Rate Divider</td>
<td>50</td>
</tr>
</tbody>
</table>

![Software component configuration](image-url)
2.5.1 Setup UART for Data Shipper

- Change the property of \[rm_comms_uart_rl\] as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component name of UART</td>
<td>Config_UART3</td>
</tr>
<tr>
<td>Channel No. of SAU UART</td>
<td>3</td>
</tr>
<tr>
<td>[UART Communication Device0] Callback Function</td>
<td>rm_rai_data_shipper_callback0</td>
</tr>
</tbody>
</table>
2.6 Generate source code by smart configurator.
   - push [Generate Code] button.

![Software component configuration](image)

2.7 Modify source code.

Add process of main function and add callback function to SCI.
   - Replace and rename sample source file to src folder.

<table>
<thead>
<tr>
<th>Source Code File</th>
<th>Destination Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>RealityAI_DataAcquisition_RL78G23_NonOS/sample/RealityAISample.c.sample</td>
<td>&quot;Project Folder&quot;/src/RealityAISample.c</td>
</tr>
<tr>
<td>RealityAI_DataAcquisition_RL78G23_NonOS/sample/Config_TAU0_1_user.c.sample</td>
<td>&quot;Project Folder&quot;/src/smc_gen/Config_TAU0_1/Config_TAU0_1_user.c</td>
</tr>
<tr>
<td>RealityAI_DataAcquisition_RL78G23_NonOS/sample/Config_UART3_user.c.sample</td>
<td>&quot;Project Folder&quot;/src/smc_gen/Config_UART3/Config_UART3_user.c</td>
</tr>
</tbody>
</table>
2.8 **Build project.**

- Right-button click “Project Name” in Project Explorer and select [Build Project] menu.

3. **How to get sensor data from evaluation board**

3.1 **Setup Reality AI Data Storage Tool**

1. Install Reality AI Data Storage Tool.
   - Select [Help]–[Install Renesas IDE Features] in e2 studio.
2. Launch Reality AI Data Storage Tool
   - Select [Renesas AI]->[Show View]->[Reality AI Data Storage Tool] menu.
3. Select Project
   - Select ["Project Name"] combo box.

4. Get data structure information from Smart Configurator
   - Push [View data structure] button in Reality AI Data Storage Tool.
   - Push [Import settings from Smart Configurator] button and push [Close] button.
4. Get connection settings from Smart Configurator
   - Push [Data connection] button in Reality AI Data Storage Tool.
   - Push [Import settings from Smart Configurator] button and Select [COM port] and push [Close] button.

Limitation: “Renesas Reality AI Data Storage Tool” V1.0.0 can not get information from Smart Configurator. So please change the settings manually.
3.2 Connect Evaluation Board and PC

- Short 2-3 in J20
- Connect PMOD (USB-UART) module to evaluation board and connect PMOD module and PC via USB.
- Connect evaluation board and PC via USB.

3.3 Modify debugger settings.

- Right-button click “Project Name” in Project Explorer and select [Properties] menu.
• Select [Debugger] tab and Select [Connection Settings] tab and Change “COM Port” to [COMX]. (X is the COM port number connecting your PC and the evaluation board.)
3.4 Execute program.

- Right-button click “Project Name” in Project Explorer.
- Select [Debug As]-[Debug Configuration] menu.
- Select ["Project Name” HardwareDebug] tree and push [Debug] button.

Push [Resume] icon on toolbar.
3.5 Get sensor data.

- Push [Data connection] button in Reality AI Data Storage Tool.
- Select [COM port] connecting “PMOD (USB-UART) module” and PC and push [Connect] button.

![Connection settings](image)

-
When sensor data is acquired, a signal appears on the Reality AI Data Storage Tool view. For the operation of Reality AI Data Storage Tool, refer to the help.
### Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
<th>Page</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0.0</td>
<td>25 Aug. 2023</td>
<td></td>
<td>-</td>
<td>First Release</td>
</tr>
</tbody>
</table>
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
   A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
   Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
   The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified.

3. Input of signal during power-off state
   Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
   Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal.

5. Clock signals
   After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
   Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in the transition period when the input level passes through the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.).

7. Prohibition of access to reserved addresses
   Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
   Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copy, or reverse engineering.

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.
   - **“Standard”:** Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
   - **“High Quality”:** Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to, unauthorized access to, or use of, a Renesas Electronics product or a system that uses a Renesas Electronics product. **RENASAS ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS PRODUCTS WILL BE INVIULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.**

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space systems; underground systems; nuclear power control systems; aircraft control systems; key plants systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Rev. 5.0-1 October 2020)

---

**Corporate Headquarters**

TOYOSU FORESIA, 3-2-24 Toyosu, Koto-ku, Tokyo 135-0061, Japan

[www.renesas.com](http://www.renesas.com)

**Contact information**

For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit:

[www.renesas.com/contact/](http://www.renesas.com/contact/)

**Trademarks**

Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

© 2023 Renesas Electronics Corporation. All rights reserved.